
About fpArchie

fpArchie is an Archie client for Windows 95. It is made for fpWare by PeterTanis and 
FrankFesevur.

The interface of fpArchie has a close resemblance to the Find applet that comes with 
Windows 95. If you can work with Find, you can work with fpArchie.

fpArchie has built in FTP support. If you have found the file you where looking for, simply 
right-click the file to retrieve it.

What is Archie?

Archie is a index on many anonymous FTP-servers all over the world. If you are looking for a
file, Archie is the way to tell where you can find this file. There are many Archie-servers 
located all over the world. They don't cover the same FTP-servers. Some Archie systems 
track archive sites globally, others only track the archive sites in their country, region or 
continent in order to reduce the load on trans-oceanic links.

There are different ways to get the information from a Archie-server, like telnet, e-mail, the 
World Wide Web or a client-program like fpArchie. These client-programs communicate via 
the Prospero distributed file system protocol with Archie servers, which perform the specified 
queries and return the results to the user.

What do I need to use fpArchie?

fpArchie requires Windows95. You also need to have a 32 bits WinSock1.1 compliant 
TCP/IP stack properly set up on your system. The WinSock TCP/IP stack that comes with 
Windows 95 works fine. To access an Archie server on the Internet naturally you need an 
Internet connection.

Since fpArchie requires a multi-threading environment, it does not run on a Win32s system.

In a next release, fpArchie also will work with Windows NT for Intel 3.51.

Why we made this product

There are three main reasons why we made fpArchie:
· We wanted to make a WinSock / Windows 95 product.
· We thought the currently available Windows Archie clients could be improved on 

interface and functionality.
· We wanted to make a product that many users can use.

Advantages of fpArchie

· It is multi-threading. So while Archie is busy, you can use your Internet connection for 
other purposes.

· It is easy to use, because it uses the same interface as the Find-applet of Windows 95 
itself.

· It displays the information while it is received. If think you have enough, simply abort the 
query.

· It has built in FTP support. So when you have found the file, you can download it right 
away.

Installing



To install fpArchie, simply move all files in the zip file to a directory of your choice. We 
recommend that you use C:\Program Files\fpWare. We are planning a decent installation 
program.

Un-installing

To uninstall fpArchie, use the Add/Remove Programs item from Control Panel. Select 
fpArchie version ## (where ## indicates the version that you are using) from the list of 
installed programs, and click the Add/Remove... button.

Basics

The basic use of fpArchie is quite simple. Enter the name of the file you are looking for in the 
Named box and press FindNow.

The default server will be contacted and the information will be retrieved from that server. 
The information is displayed in the lower part of the window.

If you want to abort the query, press the Stop button.

Look in

Use the 'Look in' field to restrict the search to a subset of hosts within a particular domain. 
Beside the normal domains, most Archie servers support several pseudo domains, that can 
be used to select larger area's in the world.

Pseudo domain Area
africa Africa
anzac OZ & New Zealand
asia Asia
centralamerica Central America
easteurope Eastern Europe
europe Europe
mideast Middle East
northamerica North America
scandinavia Scandinavia
southamerica South America
usa United States
westeurope Western Europe

You can also use eg. "mit.edu" if you want to restrict the search to the MITuniversity.

Any combination is possible. If you want all hosts in the USA and in the Netherlands, you can
simply enter "usa:nl". Or if you want all hosts in South America and Scandinavia, enter 
"southamerica:scandinavia".

Using this option has two major advantages
· It will really speed up the query and reduce the server-load.
· When you select the pseudo domain of your continent you only get the FTP sites close 

to you and that will speed up your download.

The status bar

The status bar displays information on the activity of the program. It is only displayed when 
the lower part of the window is visible.

The status bar has three parts:
· The first part, the largest one, displays information about the activity of the program.



· The second part is the progress bar. It displays the progress of the retrieval of Archie 
information.

· The third part shows an envelope when a Message Of The Day (MOTD) is received from
the Archie server.

The Message Of The Day

When a message of the day is requested and the server sends one, fpArchie can display that
MOTD in two different ways. By selecting the Message of the day from the View menu. You
can also click on the envelope in the status bar.

The MOTD can be used by the administrator of the Archie server to tell the users of the 
server important information.

Retrieving a file

When you have found the file you need, you can retrieve that file with the built in FTP support
of fpArchie.

There are two ways to start the retrieval of the file.
· You can select the Retrieve option from the File menu
· You can right click the file and the select Retrieve from the context menu.

When you start this retrieve, the FTP server will be contacted. You can see what is 
happening on the status bar. When the real download is started, a progress window will be 
displayed. You can cancel the download by pressing the Cancel button in the progress 
window.

Save results

You can save the results in a textfile. Select the Save results from the File menu. The 
information will be saved in a style like the mail or telnet access to Archie.

Response of the server

Archie servers are set up to respond to a number of requests in a queued fashion. That is, 
smaller requests get served much more quickly than large requests do. As a result, the more 
often you query the Archie server, or the larger your requests, the longer the queue will 
become, resulting in a longer waiting period for everyone's requests. Use the domain filter. 
You mostly want the sites that are the closest to you.

Query priority

Please use the priority option whenever you don't demand immediacy, or when you're 
requesting things that could generate large responses. Even when setting a low priority, you 
should still try to avoid big jobs during busy periods.

Tips

· Use an Archie-server that is located close to you. The closer the server is, the faster the 
information will come to you.

· Archie-servers don't all index the same information. Therefore it is a good idea to do the 
same query on different servers if you cannot find the file you are looking for.

· Read the Message Of The Day (MOTD). The administrator of the server can put 
important information in that message.

· An 'exact name'-search can give really return different hits then a 'part of the name'-
search.



· Specify the continent of the domains where you want to download. This will speed up the
response of the server.

How to get the latest version of fpArchie?

If you want to know if you use the latest version of fpArchie, simply use the Version info 
button in the About box. If you do so, fpArchie will try to finger petert@euronet.nl to check 
about the latest version.

You can always find the latest version of fpArchie on the World Wide Web at the next 
address:
http://www.euronet.nl/~petert/fpware

You can also find the latest version of fpArchie on SimTel or any SimTel mirror in the 
win95/winsock directory. The zip file will have a name like fpar###.zip where ### indicates 
the version.

The main address of SimTel is:
ftp://ftp.coast.net/SimTel/

Packing List

The following files must be included in a fpArchie-archive:

fpArchie.exe The program
fpArchie.doc A short description of fpArchie

The original archive was created with WinZip version 6.0. WinZip is a 32-bits Windows Zip-
file manager, that supports long filenames.

Product status

This is version 0.7 and is meant as a beta release. So please do send us your bug reports, if 
any.

Please tell other people about fpArchie, if you like this program. If you find it to be useful, it 
may be so to others. Post your comments in comp.protocol.tcp-ip.ibmpc or alt.winsock on 
Usenet.

Suggestions

We really appreciate suggestions for new features. You can e-mail us your suggestion. We 
may not reply directly to a suggestion, but please do send them. If we are going to implement
your idea we will let you know.

Reporting bugs

If you want to report a bug, please try to describe your problem as complete as you can (if 
we can't reproduce your bug, we can't fix it) and e-mail us your bugreport. We don't 
guarantee a bugfix, not even a reply, but we try to do our best.

Things you should specify:
· Windows version
· WinSock vendor and version
· Archie-server you used

Version History



Version 0.7 beta 1 Released January 18, 1996
The first public release of fpArchie.

Future plans

· Making more of the output
· Open and Save as fpArchie-file
· Concatenating queries
· Removing items from the listview
· Print the list
· Enable all the items that are always disabled

· Support the 'Match'-search types
· Display all attributes
· Better support for the domain filter

· Configurable Maximum entries to return, Maximum strings to match, Maximum hits per 
match and the Search Offset

· Expanding directories
· Better integration in the Windows 95 shell (drag and drop etc.)
· Improving the smart selection of the default Archie-server
· Getting the mail-address, used for anonymous FTP, from the MAPI
· Making the columns of the listview configurable
· Adding and removing servers. Getting available servers from a known server.
· Install/Uninstall improvement
· Much better documentation in a regular help file
· Context sensitive help
· Make it work on Windows NT
· Other languages like Dutch, German

Our addresses

If you want to contact us, please use E-mail. Here are the addresses

E-mail:
Frank Fesevur ffes@dds.nl
Peter Tanis petert@euronet.nl

License

fpArchie version 0.7 beta 1 is Freeware. You may use fpArchie free for non-commercial use. 
If you are a commercial institution wanting to use fpArchie, please consult us first. fpArchie 
may be redistributed on a non-profit base.

Disclaimer

THIS PROGRAM IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT 
SHALL THE AUTHORS, PETER TANIS OR FRANK FESEVUR, BE LIABLE FOR ANY 
DAMAGES WHATSOEVER INCLUDING DIRECT, INDIRECT, INCIDENTAL, 
CONSEQUENTIAL, LOSS OF BUSINESS PROFITS OR SPECIAL DAMAGES, EVEN IF 
THE AUTHORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Copyrights

The Archie client-server TCP/IP communication of fpArchie is partially based upon the 
Asynchronous Reliable Delivery Protocol (ARDP) library that is included as part of the 
Prospero V5.2a release. fpArchie uses its own implementation of the Prospero protocol. The 
PFS library is not used. Prospero came with two copyright notices as follows:



University of Southern California:

Copyright (c) 1991, 1992, 1993 by the University of Southern California
All rights reserved.

Permission to use, copy, modify, and distribute this software and its documentation in source
and binary forms for non-commercial purposes and without fee is hereby granted, provided 
that the above copyright notice appear in all copies and that both the copyright notice and 
this permission notice appear in supporting documentation. and that any documentation, 
advertising materials, and other materials related to such distribution and use acknowledge 
that the software was developed by the University of Southern California, Information 
Sciences Institute. The name of the University may not be used to endorse or promote 
products derived from this software without specific prior written permission.

THE UNIVERSITY OF SOUTHERN CALIFORNIA makes no representations about the 
suitability of this software for any purpose. THIS SOFTWARE IS PROVIDED "AS IS" AND 
WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT 
LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE.
Other copyrights might apply to parts of the Prospero distribution and are so noted when 
applicable.

Prospero was originally written by Clifford Neuman. Contributors include Steven Seger 
Augart, Benjamin Britt and others identified in individual modules.

University of Washington:

Copyright (c) 1989, 1990, 1991 by the University of Washington

Permission to use, copy, modify, and distribute this software and its documentation for non-
commercial purposes and without fee is hereby granted, provided that the above copyright 
notice appear in all copies and that both the copyright notice and this permission notice 
appear in supporting documentation, and that the name of the University of Washington not 
be used in advertising or publicity pertaining to distribution of the software without specific, 
written prior permission. The University of Washington makes no representations about the 
suitability of this software for any purpose. It is provided "as is" without express or implied 
warranty.

Prospero was written by Clifford Neuman.


